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1 Allgemeines
Diese Anleitung beschreibt das Gerät Line Monitor sowie die Software KEB Protokollmonitor V2.0.
Der Line Monitor ist ein universeller serieller Hardwaremonitor und wird mit der hier beschriebenen
Software bedient. Die Software kann aber auch unabhängig hiervon mit anderen Verbindungen wie zB.
dem Feldbusmonitor für F4/S4 verwendet werden.

1.1 Technische Daten Line Monitor

Spannungsversorgung Netz 100..250 VAC über Eurostecker, 50/60 Hz
Spannungsversorgung Lokal 18..30 VDC, eingespeist über D-Sub15 Buchse
Gehäuse Tischgerät, 100*100*60 mm
Betriebstemperatur -10° bis +45° Celsius
Artikelnummer Line Monitor (*) 00.F5.025-0070
Artikelnummer Kabel zum PC (in * enthalten) 00.58.025-001D
Software KEB Protokollmonitor Frei erhältlich im Internet: www.keb.de / ftp.keb.de
Artikelnummer diese Anleitung C0.00.01B-K200, über Internet erhältlich
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2 Line Monitor
Der Line Monitor ist ein serielles 2-Kanal Aufzeichnungsgerät mit Speicher für beliebige serielle,
asynchrone und HSP5-Protokolle. Die Verbindung zum PC erfolgt mittels einem KEB-Standard-
COMBIVIS-Kabel, für den Anschluss an KEB Steuerkarten oder Operatoren ist ein spezieller Adapter
(Sonde) im Lieferumfang. Als Bedien-und Anzeigeprogramm dient der weiter unten beschriebene KEB
Protokollmonitor ab Version 2.0. Die Aufzeichen- und Auslesegeschwindigkeit und das Datenformat
sind unabhängig voneinander einstellbar. So kann z.B. der Line Monitor eine 250-KBaud HSP5-
(vollduplex)Verbindung aufzeichnen und die eingehenden Telegramme mit 38,4 KBaud nacheinander
zum PC ausgeben. Dabei kann es je nach Telegrammdichte zum Überlauf des Ringspeichers im Line
Monitor kommen. In diesem Fall wird die interne Aufzeichnung gestoppt, die noch gespeicherten
Telegramme ausgegeben und dann der KEB Protokollmonitor mit einer entsprechenden
Fehlermeldung ebenfalls gestoppt.

2.1 Basisgerät
Das Basisgerät beinhaltet das Netzteil sowie die Aufzeichnungselektronik. Die Bezugspunkte GND der
D-Sub-Verbinder sind intern verbunden (keine Potentialtrennung) Das Basisgerät hat folgende
Anschlüsse:

2.1.1 Netzkabel mit Eurostecker
Dient im Normalbetrieb zur Spannungsversorgung. Spannungen von 100 bis 250 Volt AC können
verwendet werden. Ist keine Netzspannung verfügbar, so kann über die D-Sub-15 Buchse auch eine
Gleichspannung eingespeist werden.

2.1.2 D-Sub-9 Buchse
Dies ist die RS232-Verbindung zu einer seriellen Schnittstelle eines PC's über das beiliegende Kabel
mit folgender Belegung:

D-Sub-9 Female
2 RxD ->PC Pin 2
3 TxD ->PC Pin 3
7 GND ->PC Pin 5

Shield Kabel-Abschirmung

2.1.3 D-Sub-15 Buchse
Verbindung zur Sonde. Alle Signale sind als RS485-Leitungen ausgeführt, daher kann das Kabel bei
Bedarf verlängert werden (max. 100 Meter). Die Buchse hat folgende Belegung:

D-Sub-15 Female
1 Eingang für Versorgungsspannung, 18..30 VDC
9 GND für Versorgungsspannung

2,8,15 GND zur Sonde
3,10 +5V Spannungsversorgung für Sonde
4,11 RS485-Paar Kanal B Empfangen
5,12 RS485-Paar Kanal A Empfangen
6,13 RS485-Paar Kanal A Handshake
7,14 RS485-Paar Kanal B Handshake

Shield Kabel-Abschirmung

An Pin 1 und 9 kann alternativ eine Betriebsspannung eingespeist werden. Pin 9 ist dabei mit Pin 2,8
und 15 verbunden (keine Potentialtrennung)
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2.2 Sonde
Die Sonde enthält zwei D-Sub-9 Verbinder, die 1:1 durchverbunden sind, sowie hochohmige
Ankoppelung an bis zu 4 Signalleitungen. Damit kann die Sonde ohne Beeinflussung auf beliebige D-
Sub-9 Stecker/Buchsen von KEB-Geräten mit HSP5, RS232 oder RS485-Verbindungen gesteckt
werden. Eine Schaltergruppe ermöglicht die Auswahl der Betriebsart. Eine fehlerhafte Einstellung auch
bei Kontaktierung auf HSP5-Schnittstellen mit Betriebsspannungen bis zu 30 Volt führt NICHT zu
Beschädigungen. Anschlüsse an andere Schnittstellen können durch einen geeigneten,
selbstgefertigten Adapter in Verbindung mit der korrekten Betriebsarteinstellung erfolgen.

2.2.1 Betriebsart HSP5
Die Sonde wird direkt zwischen F5-Steuerkarte und F5-Operator oder auf eine Seite einer HSP5-
Verlängerung zwischen Umrichter und Operator gesteckt. Schalter S1,S2,S3 werden auf 'HSP5'
gestellt, Schalter S4,S5 stehen beliebig.

Einstellung des KEB Protokollmonitors:
Protokoll 'HSP5' oder Handshake 'Hardware, full duplex'

Abgegriffene und verwendete Signale
D-Sub-9 Signal und Pegel

2 Kanal B Empfangen TTL
3 Kanal A Empfangen TTL
5 GND
7 Kanal A Handshake TTL
8 Kanal B Handshake TTL

2.2.2 Betriebsart RS232 KEB
Die Sonde wird direkt zwischen die D-Sub-9 Buchse eines F4 oder F5-Standardoperators und dem
Kabel zur Steuerung/zum PC gesteckt. Schalter S1,S2,S3 werden auf '232/485' gestellt, Schalter
S4,S5 auf '232'.

Einstellung des KEB Protokollmonitors:
Protokoll 'DIN66019II' oder anderes 'Software' Handshake, je nach aufzuzeichnendem Protokoll.

Abgegriffene und verwendete Signale
D-Sub-9 Signal und Pegel

2 Kanal B Empfangen RS232
3 Kanal A Empfangen RS232
7 GND
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2.2.3 Betriebsart RS232 PC
Die Sonde wird direkt auf eine serielle PC-Schnittstelle (D-Sub-9 Stecker)gesteckt. Schalter S1,S2
werden auf '232/485' gestellt, Schalter S3 auf 'HSP5' und Schalter S4,S5 auf '232'.

Einstellung des KEB Protokollmonitors:
Protokoll 'DIN66019II' oder anderes 'Software' Handshake, je nach aufzuzeichnendem Protokoll.

Abgegriffene und verwendete Signale
D-Sub-9 Signal und Pegel

2 Kanal B Empfangen RS232
3 Kanal A Empfangen RS232
5 GND

2.2.4 Betriebsart RS485
Die Sonde wird direkt zwischen die D-Sub-9 Buchse eines F4 oder F5-Standardoperators und dem
Kabel zur Steuerung/zum 485-Wandler gesteckt. Schalter S1,S2,S3 werden auf '232/485' gestellt,
Schalter S4,S5 auf '485'.

Einstellung des KEB Protokollmonitors:
Protokoll 'DIN66019II' oder anderes 'Software' Handshake, je nach aufzuzeichnendem Protokoll.
Bei gebrückten Sende/Empfangsleitungen (RS485-2-Draht oder Halbduplexverbindung) kann zur
Vermeidung von Doppelaufzeichnungen das Protokoll auf 'Software, single channel' eingestellt
werden.

Abgegriffene und verwendete Signale
D-Sub-9 Signal und Pegel

4 Kanal A Empfangen RS485+(A)
5 Kanal A Empfangen RS485-(B)
7 GND
8 Kanal B Empfangen RS485+(A)
9 Kanal B Empfangen RS485-(B)
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3 KEB Protokollmonitor

Der KEB-Protokollmonitor ist eine PC-Software zur Darstellung und Analyse von seriellen
Telegrammen der KEB-Protokollfamillie. Die Software läuft unter WIN95/98/NT/2000 und benutzt eine
serielle Standardschnittstelle des PC's zum Empfang der Telegramme. Die eingehenden Zeichen
werden je nach eingestelltem Protokoll ausgewertet und zeilenweise dargestellt.
Da hierbei Telegrammanfrage und Antwort auf einer physikalischen Empfangsleitung liegen, müssen
diese zeitlich hintereinander ohne Überschneidung vorliegen (Kein Vollduplexbetrieb möglich). Dies ist
beim DIN66019-Protokoll gewährleistet (Betrieb mit F4-Feldbusadapter), im HSP5-Operatormodus
sorgt der angeschaltete Feldbusoperator für die Einhaltung des zeitlichen Ablaufs. Beim Anschluss an
den Line Monitor ist ein echter Vollduplexbetrieb mit Kanalzuordnung und Zeitstempelinformation
möglich.
Die erkannten Telegramme können gespeichert und wieder geladen sowie in die Windows-
Zwischenablage zur Verwendung in anderen Programmen kopiert werden. Es ist auch eine Schicht-7-
Dekodierung zur Darstellung der Parameterwerte in normierter Anzeige und eine Filterung/Triggerung
auf spezielle Telegramminhalte möglich.

3.1 Ansicht und Bedienelemente:

   Schnittstelle     Baudrate     Protokolldekodierung            Monitorfunktionen

Statuszeile, Kanal/Zeitstempel nur bei Line Monitor Betrieb
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3.2 Funktionen

3.2.1 Betrieb als DIN66019II-Monitor
In dieser Betriebsart werden eingehende DIN66019II-Telegramme z.B. vom Feldbusmonitor
aufgezeichnet. Das DIN66019II-Protokoll enthält neben den erweiterten Diensten auch die
altbekannten Telegramme des DIN66019-Protokolls. Klicken Sie auf den DIN66019II-Protokoll-Knopf
und wählen die gewünschte Schnittstelle und Baudrate aus. Das Zeichenformat (7 Datenbits, 1
StoppBit, gerade Parität) wird automatisch übernommen. Die Schalter für Monitorfunktionen sind dabei
ausgeschaltet. Starten Sie die Aufzeichnung mittels dem Start-Knopf links oben oder über die Taste
F9. Die Anzahl der empfangenen Telegramme wird in der Liste links oben angezeigt, die erkannten
Telegramme werden in die Liste eingetragen. Zum Stoppen betätigen Sie den Knopf links oben oder
die Taste F9 erneut.

3.2.2 Betrieb als HSP5-Monitor für Feldbusoperatoren
In dieser Betriebsart wird die Schnittstelle des PC's über ein HSP5-Adapterkabel nebst Adapter auf
Western-Stecker an die Diagnoseschnittstelle einen F5-Feldbusoperators angeschlossen.
ACHTUNG:Niemals die PC-Schnittstelle ohne spezielles Adapterkabel an eine HSP5-
Schnittstelle anschliessen! Eine Zerstörung der PC-Schnittstelle wäre die Folge.
Klicken Sie auf den HSP5-Protokoll-Knopf und wählen die gewünschte Schnittstelle und eine Baudrate
von 38400 Baud aus. Das Zeichenformat (8 Datenbits, 1 StoppBit, gerade Parität) wird automatisch
übernommen. Wählen Sie zusätzlich die aufzuzeichnenden Monitorfunktionen rechts oben aus:
Comm: Zeichnet Telegramme des Parametrierkanals (PCP-Kommunikation/SDO-Kommunikation) auf
PD Out: Zeichnet die OUT-Prozessdatentelegramme (von der Steuerung zum Umrichter) auf
PD In: Zeichnet die IN-Prozessdatentelegramme (vom Umrichter zur Steuerung ) auf
Es ist auch eine beliebige Kombination der Funktionen möglich. Starten Sie die Aufzeichnung mittels
dem Start-Knopf links oben oder über die Taste F9. Zum Stoppen betätigen Sie den Knopf oder die
Taste F9 erneut. Die Anzahl der empfangenen Telegramme wird in der Liste links oben angezeigt, die
erkannten Telegramme werden in die Liste eingetragen. Die Spalte 'ID' enthält eine fortlaufende Folge
der Telegramm-ID-Nummern im Bereich 01h bis 0Fh. Lücken in dieser Reihenfolge bedeuten, dass
der Operator die fehlenden ID's wegen fehlender Buffer nicht ausgeben konnte. Dies tritt häufig bei
aktivierten PD in Funktionen und schnellem Wechsel der IN-Prozessdaten auf, die im
millisekundentakt vom Umrichter gelesen werden, aber über die relativ langsame 38400-Baud-
Verbindung zum PC nicht schnell genug ausgegeben werden können.
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3.2.3 Aufzeichnung beliebiger Daten im Rohformat
In der Decodierungsart 'RAW' können beliebige Telegramme empfangen und hexadezimal dargestellt
werden. Die Konfiguration des RAW-Datenformates (nicht bei Line Monitor Betrieb) erfolgt mittels dem
Menüpunkt 'Raw format settings' im Menü 'Settings' oder beim Aktivieren der RAW-Funktion:

Die Telegramme werden ohne Line Monitor Betrieb in Blöcken von jeweils 16 Bytes gespeichert und
hexadezimal sowie als Text ausgegeben. Bei Line Monitor Betrieb greift die Telegrammende-
erkennung des Line Monitors (s. unten) und die Telegramme werden einzeln mit Kanal-und
Zeitinformationen dargestellt.

3.2.4 Betrieb mit Line Monitor
In dieser Betriebsart wird die Schnittstelle des PC's über ein COMBIVIS-Kabel an den Line Monitor
angeschlossen. Wählen Sie die gewünschte Schnittstelle und Baudrate aus. Die hier eingestellte
Baudrate sollte so hoch wie möglich eingestellt werden, damit die gespeicherten Telegramme
möglichst schnell aus dem Line Monitor geholt werden können. Das Zeichenformat wird bei Line
Monitor Betrieb automatisch eingestellt. Wählen Sie das zu dekodierende Protokoll zwischen HSP5
und DIN66019II oder RAW für eine undecodierte Darstellung. Die bisher getätigten Einstellungen
betreffen nur die Verbindung zwischen PC und Line Monitor, unabhängig vom aufzuzeichnenden
Telegrammformat. Die Konfiguration des Line Monitors erfolgt mittels dem Menüpunkt 'Line monitor
settings' im Menü 'Settings' oder beim Aktivieren der Monitorfunktion:

Baudrate
Hier wird die Baudrate der beiden aufzuzeichnenden Kanäle festgelegt. Diese Baudrate ist unabhängig
von der Baudrate zwischen PC und LineMonitor. Bei hohen Aufzeichnungsbaudraten, hohem
Telegrammverkehr und niedrigen Auslesebaudraten zum PC kann der Ringspeicher im Line Monitor
überlaufen. Dies führt zum automatischen Aufzeichungsstop mit entsprechendem Hinweis.

Timestamp resolution
Die Auflösung des Zeitstempels kann hier in 5 Schritten gewählt werden. Eine kleine Einstellung
bedeutet eine feinere Auflösung, kann aber bei langen Telegrammzwischenzeiten zum unerkannten
Überlauf des Zeitzählers und damit zu fehlerhafter Differenzzeitanzeige führen. Der Zeitzähler hat
einen Wertebereich von 16 Bit, entsprechend 0..65535. Eine Einstellung von z.B. 8 us ermöglicht einen
Messbereich von 8*65535 us entsprechend 524,28 ms.

Generelle Protokolleinstellung:
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Hierbei kann HSP5- und DIN66019II-Betrieb gewählt werden. Diese Einstellungen legen nur die
Telegrammendeerkennung sowie das Datenformat fest. Um die empfangenen Telegramme korrekt zu
interpretieren, muss im Hauptfenster auch das entsprechende Protokoll angewählt sein!
Ein Telegramm wird zum Zeitpunkt der Telegrammendeerkennung mit Kanalinformation sowie
Zeitstempel versehen und dann im Line Monitor abgespeichert.

Durch Drücken des 'Advanced'-Knopfes kann auf die spezielle Protokolleinstellung umgeschaltet
werden. Hierbei können Datenformat, Parität sowie Telegramm-Endeerkennung individuell eingestellt
werden. Diese Einstellungen gelten nur für erfahrene Anwender und erfordern genaue Kentnisse der
angeschlossenen Hardware und Protokolle.

Für die Telegrammendeerkennung (Handshake) sind folgende Einstellungen möglich:

Hardware, full duplex
Das Telegrammende wird auf beiden Kanälen über gesonderte Leitungen gesteuert.
Dies ist die Betriebsart für HSP5.

Software, half duplex
Das Telegrammende wird durch Ablauf der Zeit 'End of Telegram' ODER durch Empfang auf dem
jeweils anderen Kanal erkannt. Dies ist die Betriebsart für DIN66019II auf RS232-Leitungen oder
RS485-4-Drahtverbindungen.

Software, full duplex
Das Telegrammende wird NUR durch Ablauf der Zeit 'End of Telegram' erkannt. Dies ist die
Betriebsart für beliebige 2-Kanal Vollduplexprotokolle.

Software, single channel
Das Telegrammende wird NUR durch Ablauf der Zeit 'End of Telegram' erkannt. Kanal B ist hierbei
abgeschaltet um Doppelaufzeichnung von Telegrammen zu verhindern. Dies ist die Betriebsart für
DIN66019II auf RS485-2-Drahtverbindungen oder beliebigen 1-Kanal Halbduplexprotokollen.

End of Telegram
Diese Zeit wird mit Änderung der Baudrate eingestellt und gibt die Zeit in us an, nach deren Ablauf
ohne weiteren Empfang auf einem Kanal das Ende eines Telegramms erkannt wird. Sie beträgt
standardmässig 5 Zeichenzeiten, kann aber auch manuell angepasst werden.

Durch betätigen des 'OK'-Knopfes wird das Eingabefenster geschlossen. Starten Sie die Aufzeichnung
mittels dem Start-Knopf links oben oder über die Taste F9. Zunächst wird die Verbindung zum Line
Monitor aufgebaut, was je nach gewählter Baudrate mehrere Sekunden dauern kann (nur beim ersten
Start oder bei Änderung der Baudrate zwischen PC und Line Monitor). Danach werden alle
Einstellungen übermittelt und die Aufzeichnung gestartet. Sobald Telegramme einlaufen, werden sie
wie gewohnt dargestellt. Zum Stoppen betätigen Sie den Knopf oder die Taste F9 erneut.
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3.3 Programmbedienung

3.3.1 Darstellung der Telegramme
Die Telegramme werden in Tabellenform untereinander dargestellt. Mit Hilfe des Scrollbalkens rechts
oder über die Cursortasten, die Tasten Seite Auf/Ab und Anfang/Ende, kann in der Liste geblättert
werden. Die linke Spalte enthält die Telegrammnummer, daneben wird die ID des Telegramms
gezeigt. Die ID-Nummern sind fortlaufende Kennzeichnungen zur Zuordnung von Antwort zur Anfrage.
Telegramme des alten DIN66019-Protokolls sowie Sonderanzeigen haben keine ID-Nummer. Die
Spalte 'Function/Service' zeigt die Art sowie den verwendeten Dienst an:
Req Read : Anforderung Lesen, ein Wert soll gelesen werden
Rsp Read : Antwort Lesen , die gelesenen Werte oder ein Fehlercode
Req Write : Anforderung Schreiben, ein Wert soll geschrieben werden
Rsp Write : Antwort Schreiben , die Quittung auf einen Schreibauftrag
Select: Umrichteradressierung beim DIN66019II-Protokoll.
Die verschiedenen Dienste sind aus der Dienstbeschreibung KEB-Protokolle ersichtlich und
kennzeichnen die Art des Dienstes wie z.B. Schreiben des Parameterwertes oder Lesen des
Parameternamens usw.
In der Spalte 'Additional' werden weitere dienstspezifischen Angaben wie z.B. Umrichteradresse,
Parameterwert oder Name und, bei aktivierter Schicht-7-Dekodierung, auch der normierte
Parameterwert angezeigt.
Über die Taste F12 oder das Menü 'Settings->Hex Display' kann die Darstellung der Parameterwerte
zwischen dezimal und hexadezimal umgeschaltet werden.
Mittels dem Menüpunkt 'File->Clear' oder der Taste CTRL+Entfernen können alle Telegramme nach
Rückfrage gelöscht werden.

3.3.2 Klartextdarstellung
Zur Darstellung normierter Parameterwerte und Klartexte für die Dienste 0 und 1 (Schicht-7-Dekoder)
ist eine COMBIVIS 5-kompatible Parameterdatei nötig (PARAxxxx.bin, xxxx=Umrichter-
Softwarenummer). Durch Auswahl des Menüpunktes 'Settings->L7 decoder' kann diese Funktion ein-
und ausgeschaltet werden. Ist COMBIVIS 5 auf dem PC installiert, so findet der Protokollmonitor das
Verzeichnis mit den Parameterdateien automatisch. Wählen Sie die passende Datei aus um den
Schicht-7-Decoder zu aktivieren.

3.3.3 Kanal/Zeitinformationen
Wenn die Telegramme vom Line Monitor ausgelesen wurden, werden unten in der Statuszeile
zusätzlich der Kanal (A oder B) und der Zeitstempel des ausgewählten Telegramms angezeigt.
Weiterhin kann die aktuelle Zeile mittels der Taste 'M' markiert werden. Durch Auswahl einer anderen
Zeile wird die Differenzzeit zur markierten Zeile ebenfalls in der unteren Statuszeile angezeigt.

3.3.4 Exportieren in andere Anwendungen
Einträge in der Telegrammtabelle können als Text in die Windows-Zwischenablage kopiert werden.
Damit ist es leicht möglich, diese in anderen Anwendungen zu verwenden. Die Spalten werden hierbei
durch TABs getrennt, die Zeilen durch Zeilenumbruchzeichen. Wählen Sie den Menüpunkt 'File->Copy'
oder die Tasten CTRL+C aus und geben den Bereich der Telegramme ein. Es können maximal 1000
Telegramme gleichzeitig kopiert werden. Bei aktivierter Anzeigenfilterung können auch alle gefilterten
Telegramme (max. 1000) kopiert werden.
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3.3.5 Filterung
Um in der Menge der aufgezeichneten Telegramme nur bestimmte Telegramme anzuzeigen, kann
über den Menüpunkt 'Filter->Set filter' oder die Taste F2 der Einstellungsdialog für die
Filterbedingungen aktiviert werden:
Mit der Einstellung 'All' passt einer Filterbedingung auf alle Telegramme. Weiterhin müssen ALLE
Filterbedingungen auf ein einzelnes Telegramm passen um dieses Telegramm auszuwählen. Dies
kann dazu führen, dass KEIN Telegramm den Filter durchläuft. Im Zweifelsfall sollte zunächst nur eine
Filtereinstellung versucht und das Ergebnis geprüft werden. Die Filtereinstellung für 'Address' ist nur
bei Requests mit Adressangebe möglich, 'ParameterData' ist für die Dienste 0,1 und 50
(Parameterwert) vorgesehen. Prozessdaten- und Scopetelegrammwerte sind ebenfalls nur für die
entsprechenden Dienste möglich, bei anderen Diensten wird die Filterbedingung nie erfüllt sein! Die
Taste OK schliesst das Fenster wieder und aktiviert die Einstellungen.
Mit der Taste F3 kann die Anzeige gefiltert werden, d.h. es werden nur Telegramme angezeigt, die den
Filterkriterien entsprechen. Allerdings werden manchmal auch benachbarte Telegramme mit angezeigt
um z.B. bei Filterung auf eine negative Quittung auch den vorangehenden Request zu sehen.

3.3.6 Suchen
Zum Suchen nach bestimmten Telegrammen setzen Sie den Filter entsprechend und plazieren den
Auswahlbalken auf dem Telegrammeintrag, bei dem die Suche beginnen soll. Drücken Sie CTRL+F
um die Suche in Richtung aufsteigender Telegrammnummern zu starten. Wird ein passendes
Telegramm gefunden, so wird der Auswahlbalken darauf gesetzt.

3.3.7 Triggerung auf bestimmte Telegramme
Wenn Sie beim Eintreffen eines bestimmten Ereignisses die Aufzeichnung stoppen wollen, gehen Sie
wie folgt vor:
Damit nach der Triggerung nicht zuviele Telegramme gespeichert sind, können Sie über den
Menüpunkt 'Settings->Max buffer' die Maximalzahl der aufgezeichneten Telegramme festlegen. Nach
Überschreiten dieser Zahl werden die ältesten Telegramme wieder überschrieben. Setzen Sie jetzt den
Filter entsprechend des Ereignisses. Über den Menüpunkt 'Filter->Trigger' oder die Taste F4 wird die
Triggerung aktiviert und die Anzahl der noch nachfolgend aufzuzeichnenden Telegramme festgelegt.
Starten Sie mit F9 oder dem Startkopf. Beim Erkennen des gewünschten Telegramms wird, ggf. nach
Eingang der noch folgenden Telegramme, die Aufzeichnung gestoppt und ein Hinweis ausgegeben.

3.3.8 Speichern / Lesen
Zur späteren Auswertung können die gespeicherten Telegramme über den Menüpunkt 'File->Save' in
eine Datei geschrieben werden. Gespeicherte Telegramme werden über den Menüpunkt 'File->Read'
wieder geladen. Dabei gehen die bisher angezeigten Telegramme verloren.
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1 General
This manual describes the unit Line Monitor as well as the software KEB Protocol Monitor V2.0.
The Line Monitor is a universal serial hardware monitor and is operated with the software described
here. Independent of that, the software can also be used with other connections such as the field bus
monitor for F4/S4.

1.1 Technical Data Line Monitor

Voltage Supply Mains 100..250 VAC via Euro Connector, 50/60 Hz
Voltage Supply Local 18..30 VDC, fed in via D-Sub15 Socket
Housing Table Unit, 100*100*60 mm
Operating Temperature -10° to +45° Celsius
Part Number Line Monitor (*) 00.F5.025-0070
Part Number Cable to the PC (included in *) 00.58.025-001D
Software KEB Protocol Monitor Freely available in the Internet: www.keb.de /

ftp.keb.de
Part Number of this Instruction Manual C0.00.01B-K200, available over Internet
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2 Line Monitor
The Line Monitor is a serial 2-channel recording unit with storage for any serial, asynchronous and
HSP5-protocols. It is connected to the PC with a KEB-Standard-COMBIVIS-cable. For the connection
to KEB control cards or operators a special adaptor (probe) is included in the delivery. As operating
and display program serves the KEB Protocol Monitor starting from Version 2.0, described further on.
The recording and reading speed and the data format are adjustable independent from each other.
Thus the Line Monitor can record for example a 250-kBaud HSP5-(full duplex)connection and output
the incoming telegrams with 38.4 kBaud to the PC successively. Depending on the telegram density an
overflow can occur in the ring storage of the Line Monitor. In that case the internal recording is
stopped, the telegrams still stored are output and thereafter the KEB Protocol Monitor is also stopped
with a corresponding error message.

2.1 Basic Unit
The basic unit contains the power pack as well as the recording electronic. The reference points GND
of the D-Sub-connectors are internally connected (no electrical isolation). The basic unit has following
connections.

2.1.1 Line Cable with Euro Connector
Serves in normal operation for the voltage supply. Voltages from 100 to 250 Volt AC can be used. If no
mains voltage is available, then DC voltage can be fed in over the D-Sub-15 Socket.

2.1.2 D-Sub-9 Socket
This is the RS232-connection to a serial interface over the enclosed cable with following allocation:

D-Sub-9 Female
2 RxD ->PC Pin 2
3 TxD ->PC Pin 3
7 GND ->PC Pin 5

Shield Cable shielding

2.1.3 D-Sub-15 Socket
Connection to the probe. All signals are executed as RS485-lines, thus the cable can be extended, if
necessary (max. 100 meter). The socket has following allocation:

D-Sub-15 Female
1 Input for supply voltage, 18..30 VDC
9 GND for supply voltage

2,8,15 GND to the probe
3,10 +5V voltage supply for probe
4,11 RS485-pair channel B receive
5,12 RS485-pair channel A receive
6,13 RS485-pair channel A Handshake
7,14 RS485-pair channel B Handshake

Shield Cable shielding

Alternatively an operating voltage can be fed in at Pin 1 and 9. In this case Pin 9 is connected with Pin
2, 8 and 15 (no electrical isolation).
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2.2 Probe
The probe contains two D-Sub-9 connector, that are interconnected 1:1, as well as high-impedance
coupling on up to 4 signal lines. Thus the probe can be plugged onto any D-Sub-9 connector/socket of
KEB-units with HSP5, RS232 or RS485 connection without influence. Switches enable the selection of
the operating mode. An incorrect adjustment, even at contacting on HSP5-interfaces with operating
voltages of up to 30 Volt, does NOT lead to damages. Connections to other interfaces can be made
with a suitable, self-made adaptor in conjunction with the correct adjustment of the operating mode.

2.2.1 Operating Mode HSP5
The probe is plugged directly between F5-control card and F5-operator or on one side of a HSP5-
extension between inverter and operator. Switches S1, S2, S3 are set to 'HSP5' , switches S4, S5 are
arbitrary.

Adjustment of the KEB Protocol Monitor:
Protocol 'HSP5' or Handshake 'Hardware, full duplex'

Picked-off and used signals
D-Sub-9 Signal and level

2 Channel B receive TTL
3 Channel A receive TTL
5 GND
7 Channel A Handshake TTL
8 Channel B Handshake TTL

2.2.2 Operating Mode RS232 KEB
The probe is plugged directly between the D-Sub-9 socket of a F4 or F5-standard operator and the
cable to the control/PC. Switches S1, S2, S3 are set to '232/485' , switches S4, S5 to '232' .

Adjustment of the KEB Protocol Monitor:
Protocol 'DIN66019II' or other 'Software' Handshake, depending on the protocol to be recorded.

Picked-off and used signals
D-Sub-9 Signal and level

2 Channel B receive RS232
3 Channel A receive RS232
7 GND
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2.2.3 Operating Mode RS232 PC
The probe is directly plugged onto a serial PC-interface (D-Sub-9 connector). Switches S1, S2 are set
to '232/485', switch S3 to 'HSP5' and switch S4, S5 to '232'.

Adjustment of the KEB Protocol Monitor:
Protocol 'DIN66019II' or other 'Software' Handshake, depending on the protocol to be recorded.

Picked-off and used signals
D-Sub-9 Signal and level

2 Channel B receive RS232
3 Channel A receive RS232
5 GND

2.2.4 Operating Mode RS485
The probe is directly plugged between the D-Sub-9 socket of a F4 or F5 standard operator and the
cable to the control/to the 485-transformer. Switches S1, S2, S3 are set to '232/485', switches S4, S5
to '485'.

Adjustment of the KEB Protocol Monitor:
Protocol 'DIN66019II' or other 'Software' Handshake, depending on the protocol to be recorded.
With bridged transmission/receive lines (RS485-2-wire or half-duplex connection) the protocol can be
adjusted to ‘Software, single channel’ to avoid double recordings.

Picked-off and used signals
D-Sub-9 Signal and level

4 Channel A receive RS485+(A)
5 Channel A receive RS485-(B)
7 GND
8 Channel B receive RS485+(A)
9 Channel B receive RS485-(B)
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3 KEB Protocol Monitor

The KEB Protocol Monitor is a PC-Software for the representation and analysis of serial telegrams of
the KEB protocol family. The software runs under WIN95/98/NT/2000 and uses a serial standard
interface of the PC for the receipt of telegrams. The incoming characters are evaluated according to
the adjusted protocol and represented line by line.
Since telegram inquiry and response are on one physical receipt line, they must be available in
chronological order without overlapping (no full duplex operation possible). This is ensured with the
DIN66019-Protocol (operation with F4-field bus adaptor). In HSP5-operator mode the connected field
bus operator ensures the observance of the chronological operational sequence. With the connection
to the Line Monitor a genuine full-duplex operation with channel assignment and time-stamp
information is possible.
The identified telegrams can be stored and reloaded and copied into the Windows clipboard for the use
in other programs. Also possible is a layer-7-decoding for the representation of parameter values in
standardized display and filtering/triggering onto special telegram contents.

3.1 View and Control Elements:

   Interface     Baud rate     Protocol decoding            Monitor functions

Status line, channel/timestamp only at Line Monitor operation
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3.2 Functions

3.2.1 Operation as DIN66019II-Monitor
In this operating mode incoming DIN66019II-telegrams are recorded for example by the field bus
monitor. In addition to the extended services the DIN66019II-protocol also contains the well-known
telegrams of the DIN66019-protocol. Click on the DIN66019II-Protocol button and select the desired
interface and baud rate. The character format (7 data bits, 1 stop bit, even parity) is accepted
automatically. In this case the switches for the monitor functions are off-state. Start the recording with
the start-button on the top left or with the key F9. The number of received telegrams is indicated in the
list on the top left, the identified telegrams are entered in the list. In order to stop press the button on
the top left or key F9 again.

3.2.2 Operation as HSP5-Monitor for Field Bus Operators
In this operating mode the interface of the PC is connected with an HSP5-adaptor cable including
adaptor on Western-connector to the diagnosis interface of a F5-field bus operator.
ATTENTION: Never connect the PC-interface without a special adaptor cable to a HSP5-
interface! It would result in the destruction of the PC-interface.

Click on the HSP5-protocol button and select the desired interface and a baud rate of 38400 Baud. The
character format (8 data bits, 1 stop bit, even parity) is accepted automatically. In addition to it select
the monitor function to be recorded on the top right:
Comm: Records telegrams of the parameterizing channel (PCP-communication/SDO-communication.
PD Out: Records the OUT-process data telegrams (from the control to the inverter).
PD In: Records the IN-process data telegrams (from the inverter to the control).
Any combination of the functions is possible. Start the recording with the start-button on the top left or
with the key F9. In order to stop press the button or the key F9 again. The number of received
telegrams is indicated in the list on the top left, the identified telegrams are entered in the list. The
column ‘ID’ contains a consecutive sequence of the telegram-ID-numbers in the range of 01h to 0Fh.
Gaps in this  sequence mean, that the operator could not output the missing IDs because of missing
buffers. This occurs frequently in the case of activated PD in functions and fast change of IN-process
data, that are read by the inverter in millisecond cycles, but which cannot be output fast enough over
the relative slow 38400-baud connection to the PC.
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3.2.3 Recording of any Data in Raw Format
In the decoding mode ‘RAW’ any telegrams can be received and represented in hexadecimal form.
The configuration of the RAW-data format (not with Line Monitor operation) takes place with the menu
item ‘Raw format settings’ in the menu ‘Settings’ or when activating the RAW-functions:

Without Line Monitor operation the telegrams are stored in blocks of 16 bytes each and output in
hexadecimal form as well as text. With Line Monitor operation the telegram-end-identification of the
Line Monitor takes effect and the telegrams are represented individually with channel and time
information.

3.2.4 Operation with Line Monitor
In this operating mode the interface of the PC is connected over a COMBIVIS-cable to the Line
Monitor. Select the desired interface and baud rate. The baud rate adjusted here should be as high as
possible, so that the stored telegrams can be retrieved as fast as possible from the Line Monitor. The
character format is adjusted automatically with Line Monitor operation. For the protocol to be decoded
choose between HSP5 and DIN66019II or RAW for a decoded representation. The adjustments
executed so far concern only the connection between PC and Line Monitor, independent of the
telegram format to be recorded. The configuration of the Line Monitor is done with the menu item ‘Line
monitor settings’ in the menu ‘Settings’ or when activating the monitor function:

Baud rate
Here the baud rate of the two channels to be recorded is defined. This baud rate is independent of the
baud rate between PC and Line Monitor. For high recording baud rates, high telegram traffic and low
readout baud rates to the PC the ring storage in the Line Monitor can overflow. This leads to an
automatic recording stop with corresponding notice.

Timestamp resolution
The resolution of the timestamp can be selected in 5 steps. A small adjustments means a finer
resolution, but in case of long telegram intervals it can lead to undetected overflow of the time counter
and thus to incorrect difference time indications. The time counter has a value range of 16 bit,
corresponding to  0..65535. An adjustment of for example 8 us permits a measuring range of  8*65535
us corresponding to 524,28 ms.
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General protocol adjustment:
Here HSP5- and DIN66019II-operation can be selected. These settings only define the telegram end
identification as well as the data format. In order to interpret the received telegrams correctly, the
corresponding protocol must be selected in the main window!
At the time of the telegram end identification a telegram is furnished with channel information as well
as timestamp and then stored in the Line Monitor.

By pressing the ‘Advanced’ button, it can be switched to the special protocol setting. At that data
format, parity and telegram end identification can be adjusted individually. These settings are only for
experienced users and require an exact knowledge of the connected hardware and protocols.

Following adjustments are possible for the telegram end identification (Handshake):

Hardware, full duplex
The telegram end is controlled on both channels by means of separate lines.
It is the operating mode for HSP5.

Software, half duplex
The telegram end is identified by the lapse of time ‘End of Telegram’ OR by receipt on the other
channel in each case. It is the operating mode for DIN66019II on RS232-lines or RS495-4-wire
connections.

Software, full duplex
The telegram end is identified ONLY by the lapse of time ‘End of Telegram’. It is the operating mode
for any 2-channel full duplex protocols.

Software, single channel
The telegram end is identified ONLY by the lapse of time ‘End of Telegram’. At that channel B is
switched off, to prevent a double recording of telegrams. It is the operating mode for DIN66019II on
RS485-2-wire connections or any 1-channel half duplex protocols.

End of telegram
The time is adjusted with changing the baud rate and indicates the time in us, after the lapse of this
time the end of the telegram is identified without further receipt on a channel. As a standard it is 5
character times, but can also be adjusted manually.

Press the ‘OK’-button to close the input window. Start the recording with the Start-button on the top left
or with the key F9. First of all the connection to the Line Monitor is established, which can take several
seconds depending on the selected baud rate (only at the initial start or in case of changing the baud
rate between PC and Line Monitor). After that all settings are transmitted and the recording is started.
As soon as telegrams arrive, they are represented as usual. To stop press the button or key F9 again.
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3.3 Program Operation

3.3.1 Representation of the Telegrams
The telegrams are represented in tabular form. With the help of the scroll bar on the right or the cursor
keys, keys page Up/Down and Beginning/End, it can be scrolled through the list. The left column
contains the telegram number, next to it the ID of the telegram is displayed. The ID-numbers are
consecutive identifiers for the assignment of response to query. Telegrams of the old DIN66019-
protocol as well as special displays have no ID-number. The column ‘Function/Service’ displays the
type as well as the used service:
Req Read : Request Read, a  value shall be read
Rsp Read : Response Read, the read value or an error code
Req Write : Request Write, a value shall be written
Rsp Write : Response Write, the acknowledgement to a write job
Select: Inverter addressing at the DIN66019II-protocol
The different services can be taken from the service description KEB-Protocols and show the type of
the service as for example writing the parameter value or reading the parameter name etc.

In the column ‘Additional’ further service-specific specifications like inverter address, parameter value
or name and, in the case of active layer-7-decoding, also the standardized parameter value are
displayed.
Via the key F12 of the menu ‘Settings->Hex Display’ the representation of the parameter value can be
changed between decimal and hexadecimal.
With the menu item ‘File->Clear’ or the key CTRL+Remove all telegrams can be deleted after further
query.

3.3.2 Plaintext Representation
For the representation of standardized parameter values and plaintext for the services 0 and 1 (layer-7-
decoder) a COMBIVIS 5-compatible parameter file is necessary (PARAxxxx.bin, xxxx=Inverter-
Software Number). By selecting the menu item ‘Settings->L7 decoder’, the function can be activated
and deactivated. If COMBIVIS is installed on the PC, then the protocol monitor finds the directory with
the parameter files automatically. Choose the suitable file to activate the layer-7-decoder.

3.3.3 Channel/Time Information
When the telegrams have been read by the Line Monitor, the channel (A or B) and the timestamp of
the selected telegrams are displayed in the lower status line.
Furthermore, the current line can be marked with the key ‘M’. By selection of another line the difference
time to the marked line is also indicated in the lower status line.

3.3.4 Export into other Applications
Entries in the telegram table can be copied as text into the Windows-clipboard. Thus it is easily
possible to use these for other applications. At that the columns are separated by tabulation markers,
the line by line make-up characters. Select the menu item ‘File->Copy’ or the keys CTRL+C and enter
the range of the telegrams. Maximally 100 telegrams can be copied simultaneously. At activated
display filtering, all filtered telegrams (max. 100) can be copied, too.
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3.3.5 Filtering
In order to display only certain telegrams out of the quantity of recorded telegrams, the adjustment
dialog for the filter conditions can be activated via the menu item ‘Filter->Set filter’ or the key F2.
With the adjustment ‘All’ one filter condition suits all telegrams. Moreover, ALL filter conditions must fit
for a single telegram, in order to select this telegram. This can lead to the fact that NO telegram
passes through the filter. In case of doubt only one filter adjustment should be attempted and the result
be checked. The filter adjustment for ‘Address’ is only possible at requests with address specification,
‘ParameterData’ is provided for the services 0, 1 and 50 (parameter value). Process data and scope
telegram values are likewise possible only for the corresponding services, with other services the filter
condition will never be fulfilled!

The key OK closes the window and activates the settings.
With the key F3 the display can be filtered, i.e. only telegrams are indicated, that correspond to the
filter criteria. However, sometimes also adjacent telegrams are displayed, in order to see the preceding
request in the case of filtering onto a negative receipt.

3.3.6 Search
To search for specific telegrams, set the filter accordingly and place the selection bar on the telegram
entry, with which the search shall begin. Press CTRL+F to start the search in ascending order of
telegram numbers. If a suitable telegram is found, the selection bar is put on it.

3.3.7 Triggering onto Specific Telegrams
If you want to stop the recording when a specific occurrence takes place, proceed as follows:
So that after the triggering not too many telegrams are stored, you can define the maximum number of
recorded telegrams via menu item ‘Settings->Max buffer’. On exceeding this number, the oldest
telegrams are overwritten. Now set the filter according to the occurrence. Via the menu item ‘Filter-
>Trigger’ or the key F4 the triggering is activated and the number of subsequent telegrams still to be
recorded is defined. After recognition of the desired telegram the recording is stopped, if necessary
after receipt of the still following telegrams, and a reference is provided.

3.3.8 Saving / Reading
For the later evaluation the stored telegrams can be written into a file by means of the menu item ‘File-
>Save’. Stored telegrams are reloaded via the menu item ‘File->Read’. In that case the telegrams
displayed up to now get lost.
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